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VantagePoint™ PC Application Software 
for Magellan® Triton™ GPS  

Overview 
Magellan® VantagePoint™ is a powerful software application that enables users to view maps, 
Points of Interests (POIs), and customize their user-created data on a PC. You can create waypoints 
and geocaches, load maps, POIs, waypoints, geocaches, routes, tracks, add photo and audio 
recordings of your journeys and view all data on the map in VantagePoint. VantagePoint allows users 
to search for POIs and user-created data on your map to help plan a trip. The Route Planning feature 
helps map an upcoming hike, geocaching trip or other adventure, while the Track Analysis tool can 
playback the user’s experiences on the trip to share with others. VantagePoint will also remind you of 
available new software for VantagePoint itself or Triton when it is available online for you to 
download*. The Library Function helps to organize and store all of your content including Maps, Journal 
(user generated data), and Media. Then VantagePoint can synchronize your user-generated content 
with your Triton GPS or transfer your maps to Triton GPS. 
 
 

Minimum System Requirements for installing VantagePoint:  

• OS:  Windows 2000, Windows XP, Window Vista  
• Processor:  1.5 GHz  
• RAM:  256 MB  
• Video Card:  DirectX 9.0 compatible, with 64 MB of VRAM 
• HDD:  50 MB free space for installation, more free space required for maps  

 
 
For more information on VantagePoint, click on the following site*: 
 
http://www.magellangps.com/VantagePoint/   
 
 
 
 
 
       
 
 
 
 
 
 
*Internet connection required.

http://www.magellangps.com/VantagePoint/�
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Installation  
Magellan VantagePoint™ Software is contained in the CD included in the package. Close all 
applications including your web browser before starting installation of VantagePoint. Follow the 
instructions to install:  

1. Click onto MVP. exe icon then, the VantagePoint Installation Wizard will appear:   

 
 

2. To continue installation, click Next.  
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3. Read the license agreement. If you accept the terms of the agreement, click Yes.  

 

4. Choose destination for files, click Next: 

 

5. If the installation is successful, an InstallShield Wizard Complete window is displayed.   
Click Finish.  

6. When the installation of VantagePoint is complete it should create  icon on the desktop. 
The VantagePoint application is installed in the folder c:\All Programs\Magellan\VantagePoint 
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Launch VantagePoint™ 
 

The following instructions will help you launch VantagePoint™ Software. You can launch 

VantagePoint by double clicking the  icon on your desktop OR from Start\All 
Programs\Magellan\VantagePoint. When you open VantagePoint the following screen will appear: 

 

 
 
Next, you will see the screen below for creating a folder for all your GPS-related files. Click Create and 
VantagePoint will create a folder called “My GPS” in My Documents.  
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When My Gps folder is created, it will prompt you for login to register. If you do not wish to register 
at this time, click on “I will log in next time, …”.     
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Using VantagePoint  
Main Window 
After launching VantagePoint, the Main Window opens and displays the user 
interface with a Background Map*. The user interface is intuitive and easy to use. 
Toolbars have been replaced by a “Ribbon” where commands are organized into 
“Tabs” with Subtasks and Command buttons appearing after a Tab is selected: 

 

 
 

The major elements of the screen and their function are as follows: 

Tabs – Tabs are task-menus 

Toolbar – Tools for each Tab 

Left Panel – Selecting Map or Planner opens the Left Panel options 

Map Manipulator – View the Map Manipulator by scrolling over it 

Map Window – The Background map will display automatically 

Status Bar – Current selected functions are indicated on the Status Bar 

Vertical Profile – Optional feature when working with a Magellan Topo Map and user clicks 
on street or Track. The Vertical Profile is located on lower-right corner and is partially 
hidden until mouse pointer hovers over it.   

*A “Background Map” contains only major roads and landmarks, intended for areas where you haven’t loaded a detailed 
map into your GPS device.   

Map 
Manipulator 
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Map  
Window 

Status  
Bar 

Tabs 
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File Menu 
The File Menu allows you to open maps and other files or Print the map window’s current display.  

 

To open the File Menu, click on the VP Icon and select one of the following: 

Open Add maps or user data files to VantagePoint from your GPS Unit, 
SD Programmer or your PC hard drive. 

Save Save data files 

Load GPX File to 
My GPS 

Load GPX file to GPS if Magellan Triton is connected to PC 

Print Send the image displayed in the Map Viewer to printer. 

Print Preview Preview the page that will be printed  
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Search 
Click on Search, upper-right side of the screen, a dialog box opens up allowing you to 
input or refine search criteria and to view Search Results. In the default Search 
window, All finds addresses, POIs, coordinates, geocaches and other searchable 
map objects with a single search input:  

 
In the Search for field, enter the name of the object you are searching for and press 
the Search button. Results window displays the list of objects found according to 
your query. The Results are listed in the Addresses tab for addresses, in the POIs tab 
if POIs, and in the User Data tab if Journal items like waypoints, routes, track, or 
geocaches. These tabs are located at the bottom of Search dialog. Click on the object 
to view it in the Map window. The selected object is marked by a balloon on the map 
and the map view will re-center to this object. You can switch to advanced POI, 
Geocache, or Address searches at the top of Search window.   
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Style  

The Style button, next to Search tab, allows you to change the frame color:  

 

About VantagePoint   

The   button will reveal the VantagePoint software version and copyright information:  

 
 

 

Map Tab 
The Map Tab is used to view maps, manipulate the viewing parameters, and adjust geographic 
coordinates. The row below the Map Menu contains the Tools for editing a map: 

 

Tools 

       

• Map  

– View Tool turns ON/OFF functions 

– Region Zoom for maps or other items 

• Preference  

– Set measure units (Meters, Feet, etc.) 

– Set coordinate systems  

– Set North references (true north or magnetic) for a map 
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• Map Tools 

– Use the mouse pointer to select each map function 

– Create waypoints or geocaches 

– Pan, Measure Distance, Zoom in or Zoom out  

 

Browse Maps  
The Left Panel Browser allows the user to quickly view maps and turn ON or OFF. Available maps are 
organized into standard map groups with unique icons to differentiate, see below: 
 

 

 

 

Lakes USA West

BlueNav
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Map Types 
The map icons below show the types of map that can be loaded into VantagePoint. The first is a 
“Background” map which is a default map intended to be used for areas where you haven’t loaded a 
detailed map with data. The other maps types are Outdoor Maps, Street Maps, and Marine maps, all of 
which show lots of detailed information: 

 
 
Map Manipulator 
The Map Manipulator is for orienting and navigating a map. On the right side of the screen is partially 
hidden until you scroll over it with the mouse pointer, allowing full view of the Manipulator and 
operation of functions. 
 

                
 

• Manipulator  

– Scroll (Linear, 4-way): Click on the outer arrows to move the map view. 

– Spin (Rotate): Click on the inner arrows to rotate the map display. 

– Tilt: Click and hold the mouse on center moveball; move up to tilt the map to 3D 
perspective view; move down to return to 2D view. 

– Zoom: Click on magnifier to zoom in (+) or zoom out (-) of the map view. 

– Snapshot: Save current viewing parameters and available regions 

– View Snapshot: Return to a Saved Region at a later time. 

• The buttons N and 2D tools return the map back to North up and/or 2D view.   
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Library Tab    
The Library Tab is used to organize all of your content, including Maps, Journal (user generated 
content), Media, and Exchange. The icons below are used to select the individual functions:  

 

Tools 

       
 

• Library/Browse  

– Browse Maps or POIs 

• Library/Journal   
– Waypoints 
– Geocaches 
– Tracks/Trails 
– Routes  

• Library/Media  

– View, add, delete Media  

• Library/Exchange 

– Import Files  

– Export Files  
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Planner Tab  
The route Planning Tab helps map an upcoming hike or adventure. Use the tools below to create a 
route with waypoints and points of interest: 

 

Tools 

   

• The Planner feature allows the user to create routes, starting by clicking Create tool 
icon. 

– Add points by clicking on the map 

– Drag and Drop search results from Search window  

• If a Street Map is active, the user can calculate a route based on preferred routing 
method and receive maneuvers and turn-by-turn directions 

 
• The Caches Along a Route Feature will find all local geocaches that exist in your 

VantagePoint Library. 

• The Preferences item allows the user to define preferred routing method 
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Connect Tab 
The Connect Tab allows the user to connect to MagellanGPS.com.   
 

 

Tools 

 

• My Magellan  

– Create or Login My Magellan Account, View Support 

– Visit MagellanGPS.com 

– Update VantagePoint and/or Triton software 
 

My GPS Tab   
The My GPS Tab allows the user to view their connected GPS and transfer map and user data to/from 
Triton GPS.   

 

Tools 

     
• Sync   

– Synchronize user generated data 
– Transfer user generated data 

• Browse    
– Transfer maps 
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Connecting Your Triton GPS Receiver to Your PC  
Before connecting to your PC, perform the following steps on your Triton GPS: 

In Triton GPS 
1. Press the MENU button on the GPS 

2. Select VIEW on the Menu 

3. Select SETTINGS in the “View” window  

4. In the “Settings” window on the GPS, select CONNECTIVITY 

5. Select VantagePoint from the drop-down screen  

6. Connect USB Cable from Triton to PC 

Note: You should have an appropriate PC driver installed for Triton connection on PC when installing 
VantagePoint. Triton CD-ROM includes the PC driver for you to update if necessary. 

On PC   
1. Run VantagePoint on your PC 

2. In VantagePoint, click on My GPS on the Left Panel  

My GPS Left Panel  
Set your Triton GPS to VantagePoint connectivity mode (in Triton, press View > Settings > Connectivity, 
and select VantagePoint in drop-down menu) for VantagePoint to communicate with your Triton device. 
Click My GPS section at the bottom of Left Panel. When the connection is setup, your Triton device 
information will display on left panel.  

 

013900000069

1.01 

  Unit 

Model:             Magellan®  Triton 300 
Serial No.:      013900000069 
 
 

  Hardware  

Device Memory Size:   1936 Mb 
 
 
 Software 
Software version:     1.01 
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Detailed Maps  

 
 

GPS maps that can be loaded into a GPS receiver 
GPS maps that can be used on a desktop PC to program waypoints, routes and tracks, can be 
downloaded to a GPS receiver. You can use a Background map or purchased Magellan maps for 
planning a trip, during the trip and after the trip.  
 

Magellan Maps and more information at: 

http://www.magellangps.com/products/software.asp 

  
                                             
 
 

http://www.magellangps.com/products/software.asp�
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